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Overview 
Dictionary and Encyclopedia Personal Reader (DEPReader) is dictionary 
software program for PDAs, included as a bonus part in the distribution package of 
different dictionary and reference databases. DEPReader is not a dictionary or 
encyclopedia itself, you need a database to run the application. 

Supporting multiple dictionary databases in an exclusively compressed format, it 
allows you to carry your favorite dictionaries on PDA everywhere.  

In addition to the standard lookup function, DEPReader supports other search 
modes - phonetic, wildcard, error tolerance - to help you find a word or compound 
even when you do not know the exact spelling. One-tap lookup of words found in the 
dictionary definitions is provided.  

DEPReader allows you to view the cross references available in the dictionary 
entries. When using a Bible dictionary and a Bible translation compatible with other 
GMPSoft’s products, DEPReader allows immediate Bible verse look-up of the verse 
cross references via pop-up function. 

DEPReader may be personalized by customizing its layout, it allows the addition of 
personal user notes and bookmarks to the dictionary entries. 

 

Purchase Dictionary and Reference Resources 
1. Reference ToGo (http://www.reftogo.com)  
 
Reference ToGo features the authoritative and trusted English dictionaries and 
reference books of Oxford University Press. It presents best-selling English language 
dictionaries such as the Pocket Oxford English Dictionary and the Concise Oxford 
English Dictionary. 

 
� Go to Products page 
� Find the product you desire 

� Click on BUY and follow the instructions 

 
2. Bible With You (http://www.biblewithyou.com) 
 
BibleWithYou.com is the homepage of Bible With You PDA application for visualizing 
the text of the Bible. Bible With You provides instant Dictionary lookup of words in the 
Bible text via pop-up function, which does not interrupt the reading process. No switch 
between applications needed, provides recognition of inflected forms.  

 
� Go to Products page 
� Find the product you desire 

� Click on BUY and follow the instructions 



 

Warning: The screenshots herein have been taken from The Concise Oxford 
English Dictionary, The Pocket Oxford English Dictionary and The Oxford 
Dictionary of the Bible (©Oxford University Press). Note that if you use other 
dictionaries the results may differ. 
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1 Start the application 
 
Locate the Dictionary and Encyclopedia Personal Reader (DEPReader) icon 
on the Applications screen of your Palm OS handheld. Launch the application by 
tapping on the icon.  
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 



 

2 Registration 

2.1 Licenses 
To use DEPReader, you need a user license for a dictionary/reference database: 
 

1. Trial License – Includes all the functionality of the Standard License 
plus indication that the product needs to be registered. 
2. Standard License – Indicates that you have successfully licensed a 
DEPReader compatible product.  

2.2 Product Registration 
Register the product without manual unlock code input. Just install your PADUnlock 

file (PAlm Database Unlock System) on your Palm OS device. 
 
PADUnlock is a database file (.pdb type), containing your registration information 
for each one of the products you have purchased. You receive your PADUnlock file 
after you order a License for a GMPSoft product and register it in our system 
database.  
 

1. Get your PADUnlock: 
� Follow the Unlock Key link in the Sales Confirmation 

email you have received after the purchase. 
� Click on GET IT link in your Product Info page.  
� Save the file on your PC 

 
2. Install PADUnlock 

� Install the PADUnlock database in the RAM of your 
device or on the expansion card. 

 

3. Go to the Registration form: 
� Launch DEPReader 
� Tap on the Headline bar or the Menu button to display 

the form menu 

� Tap on Book 
� Tap on Registration 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

R on the silkscreen 
Or 
� Tap on the Register button in the trial reminder form  

 
 
 
 
 
 

 



 

4. Apply your PADUnlock registration information: 
� Tap on the Scan button  
 

GMPSoft products support PADUnlock file registration 
protocol and use it to automatically register your products. 

 
Note: The Trial reminder form will still appear if there is even 
one product with a Trial License state. 

 
 



 

 

 

3 Customize DEPReader 
Dictionary and Encyclopedia Personal Reader allows you to activate and search 
in the database of the installed dictionary or reference resource and even search for 
entries in several dictionaries at the same time. You can select the text size that will 
be best for you and also apply bold formatting for better visibility. 
 

3.1 Selecting a dictionary or a reference 
resource 

1. Open the Select Books form 
� Tap on the Headline bar or the Menu button to display 

the Book menu 
 
� Tap on Dictionary... 
 
 

Or 
� Draw the Graffiti Menu Command stroke   and the letter 

D on the silkscreen 
 
 

 
 

 

 
 

 
 

 

2. Scan for new dictionaries and resources 
� Tap on Scan 
 
Dictionary and Encyclopedia Personal Reader stores 
cached information about the installed dictionary databases. 

This speeds the operation when you use memory cards.  
 

It is not necessary to scan each time. Scan when you: 
• Install new Dictionary(ies) 

• Delete Dictionary(ies) 

• Transfer Dictionary(ies) from the handheld RAM to 

the memory card or vice versa 

• Move Dictionary(ies) in another folder of the memory 

card 

3. Choose one or more Dictionaries 
� Enable the checkboxes of the respective Dictionaries 

 

 

 



 

 

The abbreviation of the selected dictionary will be displayed 
at the Headline bar. 

  
4. Confirm 

� Tap on the Done button 
 

3.2 Adjusting the Preferences 
Dictionary and Encyclopedia Personal Reader allows you to adjust the way the 
information will be displayed. 
 

1. Choose Preferences from the Edit menu 
� Tap on the Headline bar or use the Menu button to 

display the form menu 
� Tap on the Edit menu 
� Tap on Preferences 
Or 
� Draw the Graffiti Menu Command stroke   and the 

letter P on the silkscreen 

  
2. Text size – you can choose Smaller size to have 

more text displayed at a time or Larger for better 
visibility 
� Tap on the down arrow next to the Text size field  
� Choose a text size from the drop down list 
 

3. Apply bold formatting to text – enabling of this 
option is recommended for people with poor 
eyesight or in case the light is not sufficient 

 
� Enable Apply Bold Formatting check box  
 

Warning: As some entries use plain and bold formatting to 
differentiate certain adjoining fields, applying this option will 

obliterate this differentiation.   

 

4. Apply colors – disabling this option will turn off the colors used in entries for 
some Dictionaries. 
� Disable Apply colors check box  
  

 
 

 

 
 

 
 

 
 

 



 

3.3 Customize the Screen Layout  
 
Dictionary and Encyclopedia Personal Reader allows fully adjustable vertical 
and horizontal screen split between the Word List window (1)  and the Entry window 
(2) and easy switching between different layouts. 

 

1. Default layout 
The default layout of Dictionary and Encyclopedia 
Personal Reader  
 

(1) The Word List window contains the Lookup field (3) and 
the three Specific Search Tabs (4).  

 
(2) The Entry window displays the word found and its 
dictionary entry which may contain the pronunciation, 
definitions, subject labels, notes on grammar, morphology 

and spelling, word origin and usage etc. 

 
Layout Selector at the right upper corner of the display allows you to specify 
the layout of the application. The Left icon shows Current Layout and the Down 
arrow button is for showing the Layout History. 
 

2. Display the most recent used Layouts 
 

Layout Selector keeps history of the most recent used 
Layouts 

� Tap on the History Layout button   (the down 

arrow) to display the list of most recent used layouts 
 

 

 
 
 
3. Display the list of all supported standard Layouts 

� Tap on the History Layout button   (the down 

arrow) to display list of most recent used layouts 

� Tap on the down arrow button   (Layout index 
button) at the bottom of the Selector to display all 
standard layouts 

 

4. Select Layout 
� Tap on an  icon representing a particular layout 

 

 
 

 

 

 

 



 

Dictionary and Encyclopedia Personal Reader supports 
4 basic layouts which you can enable by the following icons: 

 

a. Vertical Layouts , , ,   
 

 
Vertical Layouts have the Word List and the Entry windows 
separated by a vertical splitter line. 
 
 

 
 

 

 
 

b. Horizontal Layouts ,  , ,  
 

Horizontal Layouts have the Word List and the Entry windows 
separated by a horizontal splitter line. 
 

 
 

 

 
 

 
 

c. Dictionary Entry Layout  

 
Only the Entry window is displayed. 
 
 

 

 
 

 
 

 
 

d. Word List  

 
Only the Word window is displayed. 
 

 
 

 
 

 
 

 

 

 

 

 



 

5. Switching between the Most Recent Used Layouts 
 
The Layout Selector saves the history of the most recently 
used Layouts enabling you to change them consecutively.  
To go to a desired Layout included in the list of most recent 

used layouts: 
 

� Tap on the Current Layout icon at the right upper corner  

 
Each tap changes consequently the layout to next one in the 

list of most recent used layouts. 
 

� Repeat until the desired layout has been selected   

 
 

The information kept by the Layout Selector about layouts 
used is dynamic. If you stick to using only a few or even one 

or two layouts for a longer time, the Layout History index 
will be adjusted to show only them. This will save you time 

as by tapping on Current Layout icon you will rotate only 
these layouts. 
 

 

6. Adjusting the widths of the Word List and Entry 
windows 
� Tap on the splitter line 
� Move it in the desired direction until you reach the 

preferred width 

 

 

 



 

4 Smart Word List  
 
DEPReader gives instant search results in a Smart Word List for greater data 
accessibility. Unlike the standard Alphabetical Word List which is used in other 
dictionary software programs, Smart Word List shows not only the headwords 
beginning with the search word, but also those containing it. 

4.1 Smart Word List advantages: 
• Multiple Dictionary Lookup –allows you to search for words in several dictionary 

databases at the same time 

• Lists not only entries beginning with the search word, but many others that may be 
of interest for you 

• Instant positioning - the search results are displayed while you are still entering 
characters 

• Searching for inflected forms of a word – allows you to find words by searching for 
inflected forms 

• Better data accessibility in comparison to the standard alphabetic search result 

4.2 Words Search  
The Smart Word List allows finding words’ definitions not only by entering the 
exact headword but also by entering inflected forms.  

 

 For example, if you enter the inflection ‘hiding’ in the 
Lookup Field, the Smart Word List looks like this: 

 
hiding(1) 
hiding(2) 
hide… 

 
The main form of the word that is of interest to you appears 

right after the exact matches. 

 
 

With the Smart Word List, a single lookup gives you not 
only the entries beginning with the search word, but also all 

the ones containing ‘acid’ that may be of interest to you : 
 
acid 
abscisic acid 
acetic acid 
acetylsalicylic acid 
acrylic acid 
… 
valproic acid 
tricarboxylic acid cycle 
acid drop etc. 

 

 

 



 

Immediately after the actual search word, you have all the 
acids listed, which the ordinary alphabetical list does not do. 

 
Just for comparison, if you lookup ‘acid’ in other dictionary 
software, the alphabetical word list might look like this: 

acid 
acidify 
ack-ack 
acknowledge etc. 

 

The list above contains only the entries beginning with your 
search word and next entries in dictionary alphabetical 

order. 

  

4.3 Exploring Compound Terms 
When you explore the dictionary you may notice that a particular word may be found 
not only as a headword but also as part of a compound term. Generally there are 5 
sets of compounds that might include your entry, which the Smart Word List lists 
in the following order: 
 

(1) Exact match(es) 
For example, ‘acid’, ‘air’, etc. 

 
(2) Compounds including the search term as the last word  

For example, ‘compressed air’, ‘hot air’, etc. 
 

(3) Compounds with a space 
For example, ‘air ball’, ‘air bearing’, etc. 
 

(4) Compounds with a hyphen  
For example, ‘air-dry’, etc. 
 

(5) Compounds without a space 
For example, ‘airbag’, ‘airbase’, etc. 
 

In order to immediately position the Smart Word List on one of the above sets, 
use the following rules:   
 

(1) Exact match(es) 
� Enter your search word in the Lookup field 

 
The Smart Word List will position you on the exact match. 
 

 
(2) Compounds including the entry as a last word 

� Enter your search word in the Lookup field 
� Scroll down the Smart Word List with the help of the 

scroller arrows 
 



 

 
Because the exact matches of your entry are only a few, you 

may simply scroll down the results list to view the 

compounds in which your entry is the last word. 

 
(3) Compounds with a space 

� Enter your search word with a space at the end 

 

For example, enter ‘air ’ – you will immediately be positioned 
on the set of compounds formed by the word ‘air’ with a 
space. 

 
 
 
 
 

(4) Compounds with a hyphen 
� Enter your search word with a hyphen at the end 

 

For example, enter ‘air-’ – you will immediately be positioned 
on the set of compounds formed by the word ‘air’ with a 
hyphen. 

 
 
 
 
 
 

(5) Compounds without a space 
� Enter your search word and the letter ‘a’ at the end 
 

For example, enter ‘aira’ – you will immediately be positioned 
on the set of compounds formed by the word ‘air’ without 
space.  

 
 
 
 
 
 
 
Warning: As a by-product of the speed optimization, some key words may appear 
twice in the search result.  

 

 

 



 

 

5 Searching for Terms  
 
Dictionary and Encyclopedia Personal Reader supports several mechanisms for 
searching for terms. Whether you know the word or not, if you are not sure of the 
exact spelling or are uncertain of some of the letters, or even if you know only how a 
word sounds, the application can assist you in finding the correct match. 
 

5.1 Standard Search  
 

1. Enter your word in the Lookup field 
� Use the Silkscreen Graffiti area or the system keyboard 

 
The Word List window will display the words beginning with 
the characters you’ve entered while you are still entering 
them. 

 

2. Display dictionary entry 
� Tap on the exact word or on a word that is closest to the 

one you are searching for in the List window  
 

3. Scroll the Word list up/down 
� Use the smaller arrows at the right of the Word List 

window to move the list up/down by one line 

 
� Use the bigger arrows at the right of the Word List 

window to move the list up/down by one page 

 
 

5.2 One-tap lookup of words found in the dictionary definitions 
DEPReader allows you to look up words not only by entering them in the Lookup 
field, but also by tapping on the words in the dictionary definitions. 
 

1. Lookup a word from a dictionary definition  
� Tap on the word in the Entry window 
 
 

2. Display dictionary entry 
� Tap on the exact word or on a word that is closest to the 

one you are searching for in the List window  

 
 

 

 



 

5.3 Viewing Word Cross References 
The cross-references available in some of the dictionary databases are enabled as 
hyperlinks. DEPReader allows you to view cross-references by tapping on them. 
 

1. View cross-references  
� Tap on a cross-referenced word or compound found in 

the definition of a term 

 
 

 
 

 
 

 
DEPReader will immediately display the cross-referenced 
word in the Entry window. 

 
 
 
 
 
 
 
 

5.4 Viewing Bible Cross References 
Some dictionaries of the Bible, such as The Easton’s Dictionary With You, KJV 
Dictionary With You, The Oxford Dictionary of the Bible, etc., compatible with 
GMPSoft’s applications may contain cross references to verses in the Bible. 
 
If you install a Bible translation compatible with GMPSoft’s applications, DEPReader 
will give you an immediate look-up of the cross references by visualizing the Bible 
verses with pop-up window option.  
 
 

1. Install a GMPSoft Bible translation  
� Download Bible translations from 

www.biblewithyou.com 

� Follow the installation instructions for Palm OS: 
http://www.biblewithyou.com/faq.php?id=install_soft 

 

2. Activate the Bible translation in DEPReader  
� Open the Select Books form (see how in section 

3.1Selecting a dictionary)  
� Tap on Scan  
� Enable the desired Bible translation  
� Tap on Done 

 

 

 



 

 

3. Vizualise Bible Cross References 
Cross references to verses in the Bible are indicated by the 

abbreviation of the Bible Book, chapter and verse in blue and 
underlined font. 

 
� Tap on the abbreviation of the Bible Book, chapter and 

verse to open the pop-up window 

 

 
 
 
 
 
 

4. Exit pop-up window  
� Tap anywhere on the screen 

 
 
 
 
 
 

5.5 Exploring Hebrew/Greek Strong’s Lexicons  
 
When a Hebrew/Greek Strong’s Lexicons is enabled, DEPReader allows you to 
search its content by the Strong’s numbers or by the English transliteration of the 
words indicated by a particular Strong’s number.  
 
Strong’s numbering system has been created by Dr. J. Strong in connection with 
studying the Bible in the original languages. Each Strong’s number stands for a 
Hebrew and Greek word from the original texts.  
 
The format of the Strong’s numbers in our lexicons is as follows:  

H0001 – where H indicates it is for an original Hebrew word 
G1126 – where G indicates it is for an original Greek word 

 
Some Strong’s numbers have modifications, indicated by a letter at the end: 

H2425a and H2425b  
 
A transliteration of a Hebrew/Greek word is the English recording of how it sounds. 
For example, the Strong’s number G3339 stands for the old Greek word 
µεταµορφοω which is transliterated as metamorphoô. 
 

 

 



 

1. Enter a Strong’s number in the Lookup field 
� Use the Silkscreen Graffiti area or the system keyboard 
 

Enter the Strong’s number according to the format given 
above. 

 
 

2. Display the Strong’s definition  
� Tap on the Strong’s number in the search result  
 

 

 

3. Search for a modification of a Strong’s number  
� Enter a Strong’s number as described in step. 1 
� Enter a space at the end 

 

If the Strong’s number has modifications they will appear on 
top of the search result. 

 

 
 
 
 

4. Search by the English transliteration of the original 
words 
� transliterated word in the Lookup field 
� Use the Silkscreen Graffiti area or the system keyboard 

 

The Word List window will be positioned on the Strong’s 
number which matches your search criteria. 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 



 

5.6 Exploring Stats and Lists  
 
DEPReader supports a number of reference resources that provide valuable 
information on selected subjects such as Movie List, Church List, Tennis Stats, 
Snooker Stats etc. The exploration of these databases is exactly the same as with the 
dictionary databases.  
 

Download Stats and Lists databases from: 
www.depreader.com 

 
1. Enter a search term in the Lookup field 

� Use the Silkscreen Graffiti area or the system keyboard 
 

Check the product page of the particular database to see 
what terms you may use to explore it.  

 

For example, the Movie List database may be explored by the 
Movie titles, the names of the actors, actresses, the directors, 

writers and by character names.  
 

2. Display an item from the result  
� Tap on a word in the list  
 

 
 

 

 
 
 
 
 
 

5.7 Most Recently Used (MRU) Searches 
The application saves a MRU list of the words and letters that 

were entered in the Lookup field. A record of what is entered 
in the Lookup Field is created each time you tap on a word in 
the Word List to display its dictionary entry.  
 

1. Display the list of most recently entered searches 
for words or letters 
� Tap on the down arrow at the right of Lookup field 
 
 

 

 
 

 

 

 

 



 

5.8 Error Tolerance Search 
If you are uncertain of the correct spelling of a word or have not received a result 
with the Standard Search and you suspect you may have mispelled it, you may try 
Error Tolerance Search to receive suggestions for words whose spelling is close to 
the word you have entered. 
 

This search is helpful when you have (1) added extra 

letter(s), (2) missed letter(s), (3) confused letter(s) or have 
(4) transposed letter(s).   

Examples:  

(1) ‘refference’ – for an extra letter   
(2) ‘narow’ – for missing letter,  
(3) ‘vizualize’ – for confused letter(s)   
(4) ‘downlaod’ – for transposed letter(s)  
 

1. Enter a word in the Lookup field 
� Use the Silkscreen Graffiti area or the system keyboard 

 

2. Perform an Error Tolerance search   
� Tap on the Green Search Tab  

 
As a result, the reader will display a list of words in the 

selected dictionary that may be obtained from the one you 
entered by adding, removing or changing a letter, or by 

transposing some of the letters.  

 

3. Display the dictionary entry of a word 
� Tap on a word in the search result 
 

4. Exit Error Tolerance search 
� Tap again on the Green Search Tab 
 

5.9 Phonetic Search 
The Phonetic Search feature allows you to search for words knowing only their 
pronunciation. 
 

1. Enter the word as it has sounded to you in the 
Lookup field 
� Use the Silkscreen Graffiti area or the system keyboard 

 
For example, if you have heard ‘karat’, enter this suggestion 

in the Lookup field. 
 

2. Perform a phonetic search   
� Tap on the Pink Search Tab  
 

DEPReader will display a results list of the words that are or 
may be pronounced like what you have heard. The words 

 

 



 

are listed by how likely it is for them to be pronounced like 
your search term – the top of the list shows the words that 

have exactly the same or closest pronunciation. 

 

3. Display the word entry 
� Tap on a word in the search result 
 

4. Exit phonetic search 
� Tap again on the Pink Search Tab 
 

5.10 Crossword Search  
Suppose you are doing a crossword and you come to a clue you simply can’t solve, 
or a sequence of letters that looks like no word you know. Your only hints are the 
length of the word and a few letters. 

 

1. Enter your word in the Lookup field 
� Use the Silkscreen Graffiti area or the system keyboard 

 
Substitute each missing character for a question mark (?)  

 
2. Perform a crossword search   

� Tap on the Blue Search Tab  

 
The result will be a list of the words matching the criteria by 

having the same length and the known letters in the 

appointed positions.   
 

3. Display the word dictionary entry 
� Tap on a word in the search result 
 

4. Exit crossword search 
� Tap again on the Blue Search Tab 

 

 

 



 

6 Tables 
DEPReader supports the tables provided by some dictionary databases. Tables may 
contain one or more columns with entries on a certain topic. The names of the tables 
are indicated by capital letters.  

6.1  Working with tables  
1. Choose Tables… from the View menu 

� See how in section…. 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 

� Tap on Tables… 

Or 
� Draw the Graffiti Menu Command stroke   and the letter 

L on the silkscreen 
 

 

2. View Next or Previous Tables 
� Tap on the forward or on the backward arrows in the 

Headline bar  
 

Some dictionary databases may contain more than one table. 

 
 

 
 

 

 
 

3.  Look up a term or compound from a table with 
DEPReader: 
� Tap on a term or compound in the table  

 
DEPReader will perform a search for that term or compound. 

The Smart Word List will be positioned on the items that 
closely match your query.  

 

For more on the Smart Word List, read Section 4 Smart Word 
List. 

 
 

 

 
 

 
 

 
 

 

 

 

 

 

 



 

 

4. Open a table from the Lookup field: 
 

Some terms may be included in a dictionary database both 
as dictionary entries and as table entries. Tables related to 

the search term are listed in the search results when you 
perform a search for such terms. 

 

For example, the term ‘filbert’ (from POED) is both a 
dictionary entry and is included in the table NUTS. 

 
� Perform a search in DEPReader – see how in section 5 

Searching for Terms 

 
Entries in the Smart Word List denoted as cow(list) – show 
that the entry is an item from a table. 
 

Entries in the Smart Word List such as NUTS (denoted by 
capitals) indicate a table.  
 

In order to open a table:  
� Tap on an entry in the Smart Word List that is denoted by  

…(list) 
Or 
� Tap on the name of the table to open it 

 
 

 
 

5. Returning to DEPReader 

� Tap on the DEPReader icon, , at the right upper 

corner of the screen 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 

 

 



 

7 History 
 
Dictionary and Encyclopedia Personal Reader keeps a history of the dictionary 
entries displayed, allowing you to move back and forward in the history list.  
 

1. Go to the previous entry displayed 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 

� Tap on Previous 
Or 

� Tap on the Back Arrow   icon in the Headline bar 
 

 
 

2. Go to the next entry in History 
� Tap on the Headline bar or the Menu button to 

display the form menu 

� Tap on View 
� Tap on Next 
Or 

� Tap on the forward Arrow   icon in the Headline bar 
 
 

 

 

 



 

8 User Notes 
 
Dictionary and Encyclopedia Personal Reader allows you to add your personal 
notes to dictionary entries you have checked in one or in all of the dictionaries that 
are installed.  

 
You may have notes to entries in one of the dictionaries 

installed as well as notes to entries in different dictionaries. 
If a word exists in a number of the dictionaries installed, you 

can have separate notes to the same word for the entries 

found in the different dictionaries.  

8.1 Attach a Note 
1. Select a word  

� See how in section 5.1 Standard Search. 

 
2. Attach a Note 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on View 

� Tap on Edit Note 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

I on the silkscreen 

� Tap on the Add Note ( ) icon in the Headline bar   

 
A Note will be attached to the word’s definition provided by 

the particular dictionary only. 
 

3. Enter your text 
� Use the Graffiti Silkscreen area or the System Keyboard 
 

4. Change the Note category 
� Tap on a Notes category displayed at the right upper 

corner of the screen 

� Tap on the desired category in the list 
Or 
� Click on the Details button 
� Tap on the down arrow displayed after Category 
� Select a category from the list 

� Tap on OK 
 
 

5. Exit Note 
� Tap on Done 
 

 

 

 



 

8.2 Edit a Note 
You may edit a note, if one exists for an entry in a particular dictionary. 
 

1. Edit Note for a dictionary entry 
� Select a dictionary entry  

� Tap on the Add Note ( ) or Edit an Existing Note ( ) 
icon in the Headline bar   

 
Or 
2. Open Notes window 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on View 

� Tap on Notes… 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

N on the silkscreen 
 

3. Open a Note 
� Tap on a Note in the list 

 

4. Edit a Note 
� Edit the text of the note 

 
 

8.3 Manage Notes Categories 
1. Open Notes window 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on View 

� Tap on Notes… 

Or 
� Draw the Graffiti Menu Command stroke   and the letter 

N on the silkscreen 
 

2. Open Edit categories window 
� Tap on All in the right upper corner to display the 

categories list 

� Tap on Edit Categories… 
 

3. Create new Notes category  
 

� Tap on New 

� Enter the new category name 
� Tap on OK 
 

 
 

 

 

 

 



 

4. Rename Notes category  
 
� Tap on a Notes category in the list 

� Tap on Rename 
� Enter the new name 

� Tap on OK 

 
5. Delete a Notes category  

� Tap on a Notes category in the list 
� Tap on Delete 

9 Bookmarks 
Dictionary and Encyclopedia Personal Reader allows you to Bookmark specific 
words and store Bookmarks in different categories.   

 

You may bookmark entries in one of the dictionaries installed 

as well as bookmarks to entries provided by the different 
dictionaries installed. 

 
If a word definition exists in a number or all of the 

dictionaries installed, then each – e.g. you can add separate 
bookmarks to the same word for the entries provided by the 

different dictionaries.            

9.1  Bookmark a word 
6. Select and display a dictionary entry 

� See how in section…. 

 

7. Choose Add to Bookmarks from the View menu: 
� Tap on the Headline bar or the Menu button to display 

the form menu 
� Tap on View 

� Tap on Add to Bookmarks 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

O 
A Bookmark will be added to the word’s definition provided by 

the particular dictionary only. 

9.2  Manage bookmarks  
1. Choose Bookmarks from the View menu: 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on View 

� Tap on Bookmarks 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

K 
Note: You need to have at least one bookmark in order to 
open the Bookmarks form.  

 

 



 

 
2. Select a bookmark 

� Tap on it in the list 

 
3. Edit a bookmark – you can change the name of the 

bookmark and the category it belongs 
� Tap on Edit 
 
 

3.1. Rename the bookmark 
By default, Bookmarks are named by the respective word.  

�  Enter the new name 

 

3.2. Change a bookmark’s category – you can choose the bookmark’s category from 
the list of current categories or create a new category. 

� Tap on the triangle button against Current category 
� Tap on a category in the drop down list 

 

 
4. View a bookmark 

� Tap on Go To 
Or  
� Tap on it again 
 

Warning: Because a Bookmark is being added to an entry in 
particular dictionary, Go To will work only if that dictionary is 
active. 

 

5. Delete a bookmark 
� Tap on Delete  
 

6. Exit Bookmarks screen 
� Tap on Back 

9.3 Manage Bookmark Categories 
1. Choose Bookmarks from the View menu: 

� Tap on the Headline bar or the Menu button to display 
the form menu 

� Tap on View 

� Tap on Bookmarks 
Or 
� Draw the Graffiti Menu Command stroke   and the letter 

K 
 

Note: You need to have at least one bookmark in order to 
open the Bookmarks form.  

 
 
 

 

 

 



 

 
2. Create a new category 

� Tap on the drop down arrow next to Current field 
� Tap on Edit Categories... from the Category list 
� Tap on New 

� Enter the category name 

� Tap on OK 
 

 

3. Rename a category 
� Tap on a category in the list 

� Tap on Rename 
� Enter the new name 

� Tap on OK 

 
 
4. Delete a category 

� Tap on a category in the list 

� Tap on Delete 
 
 

5. Exit Edit categories screen 
� Tap on Back 
 

 



 

10 Contact and support 
 
Technical Support 
For technical or software related inquiries: 
E-mail: support@depreader.com  
 
Sales 
For general, product and sales related inquiries: 
E-mail: sales@depreader.com  
Sales points: www.depreader.com  
 
Partnership and Business Development 
For partnership, B2B development or special sales inquiries: 
E-mail: ceo@depreader.com  
 
 
For detailed information on products, sales and registration or technical support, 
check our Web site: www.depreader.com.  
 
 
 

11 Copyright information 
 

Dictionary and Encyclopedia Personal Reader (DEPReader) 
This product and the algorithms used are property of GMPSoft. All rights reserved 
2004-2006. 


